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1 Introduction

1.1 Welcome to AquaSoft ® SlideShow

We are happy that you have decided to buy AquaSoft ® SlideShow. AquaSoft ® SlideShow is
the perfect solution for creative use of your snapshots. In the shortest time your images will fly,
zoom and rotate around the screen and delight you with innumerable effects.

With only a few clicks is such a slide show created and burned to DVD or CD, ready to be handed
down or for a relaxing night on the sofa.

Plunge into the world of AquaSoft ® SlideShow. You won't regret it.

Quick guide on how to create a slide show

Legende:

Features that show this picture are introduced in AquaSoft ® SlideShow in an
example slide show.

Features with this picture are explained further in a tutorial in the help. Just click the
picture to get to the tutorial.

The exclamation point indicates important information. We strongly recommend
that you read them.

The small i shows that the text is of informative value. It doesn't have to be read,
but it is, to all intents and purposes, interesting.

The light bulb points to tips you don't want to miss.

2 First steps

2.1 First steps with AquaSoft ® SlideShow

Start the program, then select an empty 4:3 slide show in the "Welcome dialog".

Before you start with your work switch to "View" -> "Layout". Here you will also find the
"Timeline". 
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1. Adding images

You can select end add photos via "Add" -> "Images". You also can add whole directories
via "Add" -> "Directory". The selected images will be displayed in the "Timeline". By using
"Edit" -> "Sort" you can get the images into a certain logical order, e.g. by their EXIF-
exposure date. Naturally, you sort your images manually, as well.

2. Adding background music

Music enriches your live and your show. Via "Add" -> "Background music" you can select
music titles by clicking the "Plus"-button. The order of the titles can be changed by moving
them with the mouse.

Remove titles from the list by clicking the "Trash bin"-button. If you select a title you can
adjust its settings. Then click "OK". The music titles will be displayed in the "Timeline".
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3. The show can begin

This quick you can see results. In two steps you added pictures and music, and now you can
play your show. To do this click the "Play"-button in  the menubar or "F9". Transitions are
selected randomly and each time you play the show your images have a different transition. 

That's not enough yet? You want to specify the display duration, enter text and define
transitions yourself? No problem with AquaSoft ® SlideShow!
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4. Image properties

Select the first image. On the right side you will find the image properties. Here you can assign
a fixed transition, text and comments to the image. You can also customize the duration of the
image.

If you want to change the duration of several images at once select all images that
are to be edited via "Ctrl"+"A" in the Image list and change the value of the duration.
It will be assigned to all selected images. Under Program settings you can also
change the default value for the duration. These changes then apply to all images
that have "Use default duration" checked.

5. Specifying transitions

If you don't want to leave the transition to chance select the one you want from the list. If you
click the "Adjust"-button you can further edit the transition properties.

With the -button ("... from here") in the menubar you can play the show from the
position of the currently selected image.
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6. Text fade-in

Under object settings for images you can find
the tab "Text". Here  you can enter text to
accompany the image and also add
formatting. The text can have an animation
applied as well. After clicking the "Edit" -
button you can customize this animation and
specify whether or not to leave the text in
place after playing the image. If you activate
the function "Show text with  image" the
text will be displayed together with the image
and will not be animated separately.

7. Commenting images

On tab "Sound" you can record a comment
via a connected microphone. To do this click
the "Record" -button. The duration of the
image will be automatically adjusted to the
comment. Alternatively you can assign a
specific sound file to the image. Click on the
yellow folder to select the file.
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8. Ken Burns Effect

SlideShow provides predefined "Movement paths" in the "Toolbox". Among them you can
find the "Ken Burns Effect". Drag the Ken Burns Effect from the "Toolbox" directly to an
image in the "Timeline". Now play that image. There are many more options to animate
images with zooms and camera pans. You can find more information about this at a later point
in this manual.
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9. Image effects

Just as easy as adding a Ken Burns Effect you can assign other special "Image effects". To
do this go to "Image effects" in the "Toolbox". Drag an image effect to an image in the
"Timeline". Click on this image and you will see it in "Layout designer" with the effect
applied.

Image effects influence how an image is displayed. They are not transitions. Those you can
find in the image properties (Box 4 on this page) and under "Transitions" in the "Toolbox".
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10. Creating a collage

In the "Toolbox" you can find the "Collage" -object. It allows to display several images and
texts at the same time. Simply drag it from the "Toolbox" to the "Image list" to insert it into
the slide show. Now select those images from the Image list that you wish to include into the
collage and drag them to the "Collage" -object. Expand the collage so that the images are
displayed. Under object settings for collages you can select the transition you want to apply.
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11. Editing a collage

Select the first image in the collage and resize it in "Layout designer" by using the position
frame at the edges of the image. Now position the image. Repeat these steps with all images
in the collage. In the Toolbox you can also find the "Text" -object. Select the last image in the
collage, then click the "Text" -object to insert it. The text will be added as the last object of the
collage. On the "Text" -tab in Object setting you can add and format text. Now position it.
Select the collage from the Image list and click the "... from here" -button to play the collage.

12. The powerful chapter

One image track is not enough for you? Then you can utilize the chapter. In contrast to the
collage images and text inside a chapter don't lose their own animations and can also be
temporally offset. Insert a "Chapter" -object and drag two images into the chapter. Open the
chapter by clicking on the "Plus" -symbol, select the last image in the chapter and then
double-click the "Text" -object in the "Toolbox" to add text after the image. To create a new
track move the second image in the "Timeline" under the first. A red bar appears, which helps
you with the positioning. Now move the "Text" underneath the second image and assign an
animation to the "Text" -object via the "Object settings". 
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13. Temporal fine tuning

Extend the duration of the first image to 10 seconds. To do this simply drag the right edge of
the preview image farther to the right. Then move the second image to the right also using the
mouse. Extend the text and move it inside the "Timeline" a few seconds to the right. Select
the "Chapter" and click the "... from here" -button. The text appears after the first image has
been displayed for a few seconds and will be shown with an animation. In this example the text
will also be shown in the second image.

14. Chapters can do even more

Chapters offer a variety of other options. Decrease the size of the second image inside the 
"Layout designer". In "Object settings" deactivate the function "Fill". Now move the image
a little inside the "Timeline". Play the chapter again using "... from here". This way you can
easily create many different picture-in-picture effects.
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15. The chapter on a DVD?

The chapter also serves to divide the show into different parts. It helps to keep the overview in
large shows. In addition these chapters can be utilized in a  DVD-menu later. (Feature of 
SlideShow-Manager, which is part of SlideShow Studio 6.)

After to finished the creation of your show you can create a DVD for the DVD-player. This isn't
necessary if you wish to continue to play the show on the PC.

16. Burning

Under "Wizards" you can find the "SlideShow-Manager". Here you can specify which menu
to use to create your DVD. Select a template,  then go to "Project" -> "Burn project". The
"Video-DVD" is for the DVD-player. A self-starting CD/DVD for PC will be created under "PC
show".

If you're using SlideShow Deluxe 6 select "Video-Wizard" to create a DVD for DVD-player.
The "CD/DVD and Archive Wizard" creates a self-starting CD/DVD for PC.

The conversion of a slide show into a video can take some time. After that you can put the
burned DVD in your DVD-player and start the show.

Now you've created a slide show with effects and background music. Your family and friends will
be impressed.

Naturally, there is much more to discover, and you can now start with experimenting with the 
multitude of other possibilities in AquaSoft ® SlideShow. Editing images, using zoom
functionality, recording comments, burning CDs/DVDs, etc.

2.2 Program overview

Structure of the user interface

AquaSoft ® SlideShow includes several tools to edit your show. In the following graphics you get
an overview over the available controls. Often will be talked about objects. Objects are all element
that can be added to a slide show, e.g. images, text, music or collages.

The description of the controls is given with respect to the "Layout" view. You can select
it via "View" -> "Layout".
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The toolbar

Creates a new empty show.

Opens an existing show.

Saves your show.

Adds images to your show.

Opens the dialog to add background music.

Opens the slide show settings. The settings only apply to the currently opened show.

Plays your show from the beginning.

Plays your show from the current position.

Opens the Export Wizard.
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Allows to search for text, file names and keywords inside your slide show.

Loads SlideShow's "Toolbox" view.

Loads SlideShow's "Layout" view.

Loads SlideShow's "Storyboard" view.

Loads SlideShow's "Image List" view.

The Image list

All objects of your current slide show are displayed in the "Image list". In addition, further useful
information about the objects are displayed as well.

Here you can see the start time and duration of the objects. For images there is an entry for file
size, file date and file name.

A check mark in the "EXIF" column means that the image contains EXIF data (e.g. exposure date,
camera model and image resolution). These can be displayed in AquaSoft ® SlideShow. More
information about this can be found in chapter variables.

Another important column is "Track". It shows in which track of the "Timeline" your object is
located. If this entry is empty then your object is in the first track. But you can create multiple tracks
inside a chapter, and the column "Track" informs you about the object's track number. Of course
you can also see this in a graphical way inside the "Timeline".

You can change the order of the images by moving them with the mouse.

The Storyboard

Here you can switch to the "Storyboard". It shows a small preview, called thumbnail, of all images
in the show. This makes it easier to find a certain image in case your show grew rather large. Here
too you can change the order of the images by moving them with the mouse.
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With the slider at the bottom edge of the "Storyboard" you can specify the size of the thumbnails.

The Layout designer

The "Layout designer" is your preview window. Here you can see how images and text will be
displayed on the monitor. 
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The following icons are available in "Layout designer":

Zooms into the preview in Layout designer.

Zooms out of the preview in Layout designer.

Sets the view/window size back to its normal size

Toggles the raster that objects can be magnetically aligned on

Zoom and camera pans can be set in "Layout designer" by defining movement marks. You can
find the necessary buttons in the toolbar of the Layout designer. They will be explained in the
respective chapters.

There are two distinct areas in Layout designer - the visible and the invisible area.

The visible area represents your monitor. Everything inside this area will be displayed later on the
monitor. The invisible area is outside the visible area. We need it to be able to let text, images and
other objects fly into the visible area. It means that movements can already take place outside of
the visible area  and then continue to move into the visible area.  This way you can for instance let
text run from left to right over the screen. The magnifier icons can be used to increase or decrease
the size of the visible area.

The Object settings

Each SlideShow-object (image, chapter, collages, ...) has certain properties that will be displayed
when you select the object in Image list, Timeline or Storyboard. In the following graphic you see
the settings for an image. Objects and their properties will be explained in more detail later in this
documentation.
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You can specify the duration of your image and its transition, for example. On the "Text"-tab you
can add and format text. And on the "Sound"-tab you have the option to assign a special
comment or sound to your image.

The Toolbox

The "Toolbox" is the place where you find all the objects that can be added to a slide show. You
can click on them and drag them with held-down mouse button to position in the "Image list". This
process is called drag&drop. By double-clicking an object it will be added at the end of the show.

When you click on the "Transitions"-tab in the Toolbox you find a large selection of pre-defined
transition effects. Click on a transition and you will get a small preview of the effect. If you want to
assign a transition to an image drag it with held-down mouse button to the image (drag&drop).
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The Timeline

The Timeline displays the temporal flow of your slide show and all containing images, texts and
musical scores. By using "Chapters" you can create multiple tracks. Images and sounds can be
spread over these tracks inside the "Chapter". You can find it in the "Toolbox" on the tab "Slide
show objects".

Here you learn how to create multiple tracks.
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3 Design options in AquaSoft ® SlideShow
We recommend you to first read the section "First stept with AquaSoft ® SlideShow" prior to the
following tutorials. There you will receive an insight into the basic functions of the program.

In the “Program overview“ section the working environment of AquaSoft ® SlideShow is
explained to you.

3.1 16:9 or 4:3?

At first you have to specify the aspect ratio you want to create your slide show in. The aspect ratio
defines the ratio between image width and image height.

If you want to show your slide show on TV later the aspect ratios of 4:3 and 16:9 come in handy.
Older CRT-TVs only support the ratio of 4:3, while modern flat-panel TVs support both 4:3 and
16:9.

If your images are in format 4:3 or 3:2 (digital single-lens reflex cameras) select 4:3 as aspect
ratio.

If they are in 16:9 format select this format respectively.

In case you want to use the format 16:9 even though your images don't have this format, the
images need to be adjusted into the 16:9 format. This is not possible without "cropping" the images
a little at the top and bottom. Without this cropping it is technically impossible to display a
distortion-free image.
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Initial state
Adjusted by

"automatic" cropping
Adjusted by

"automatic" stretching

What do you have to do now?

Insert an image into an empty 16:9 slide show.

You see the black borders left and right of the image.

Decrease the size of the visible area in Layout designer by clicking on the icon. Now increase
the size of the image by dragging the handles at the corners of the position frame until the black
borders disappear. At last position the desired area of the image in the visible area.

Now it should look similar to the next graphic:
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You can save this positioning to a template so that you don't have to repeat this process for every
single image. To do this simply drag the image from the "Image list" to the "Toolbox" and specify
a name for the template in the now opening dialog.

After clicking "OK" you can find the template in the "Toolbox" under "Slide show objects" ->
"Custom objects".
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To add additional images in 16:9 format, simply drag the saved template with pressed mouse
button onto the "Timeline" or the "Image list". The dialog to add  images appears. Now select the
images you want to add, and they will be inserted with the settings of your custom template.

3.2 Transitions

Every image in AquaSoft ® SlideShow can get a transition assigned. This can be done by
changing the settings in the "Object settings" window,  but also via the "Toolbox".

Add an image to an empty slide show. To do this use the -button in the menu bar.

You can add several images at once by selecting them in the file selection dialog.
Press the "Ctrl"-key and click on the images you want to add.
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About the Toolbox

In then "Toolbox" you find the "Transitions"-tab. When you click on a transition you will get a
small preview.

Via Drag&Drop (moving with the mouse) you can now assign a transition to an image. Click the
transition with the left mouse button and hold it down. Move the transition to the target image in
the "Timeline". Release the button when a red border appears around the image.

Click on the image and then on  to play the image with the transition. You can stop the
replay at any time by using the "Esc" -key on your keyboard.

You see the specified transition in the object properties of the image. There you can also change it
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and even customize it. The following text will give a more extensive description.

If you click on an image in the "Timeline" with the right mouse button a pop-up menu will provide
you with the option to select a transition.

About the Object settings

Every object in a slide show has a set of so called "Object settings". In the "Object settings" of
an image you can e.g. set the "Duration", specify a "Transition" and enter a "Text". Right now
we only want to talk about the "Transition". Here. you can find more about "Object settings".

Click on an image in the "Image list" or "Timeline".

If you don't see "Object settings" in your current view you can open it via right-click on
the image. Alternatively you can reach the "Object settings" under "View" ->
"Controls".

The transition is set on the "Image" -tab in the "Object settings".
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In the transition list you can see all pre-defined transitions and select one. Each transition is
customizable after clicking on "Adjust". 

If you want to change the transition for several images at once just select these image
in the "Image list" and set the desired "Transition" in the "Object settings". It will be
assigned to all selected images.

Via "Ctrl+A" you can select all objects in the image list. With the held down "Ctrl" -key
and mouse clicks you can select several single images. 
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3.3 Text animations

Of course a slide show should also have text, and it shouldn't be just simply displayed but it should
be possible to animate it.

In AquaSoft ® SlideShow you can enter text to an image or display it on a colored background.
Texts also can fly over the image along freely  definable movement paths.

3.3.1 Text to images

In the "Object settings" of an image there is a "Text" -tab. The "Object settings" will be
displayed when you select an image in the "Image list/Storyboard/Timeline" via mouse click.

If you don't see "Object settings" in your current view you can open it via right-click on
the image. Alternatively you can reach the "Object settings" under "View" ->
"Controls".

Here you can enter text to an image and assign formatting like font, font size and font color. 

The available formatting options are almost self-explaining due to their icons, and you probably
know them already from word processing applications.

The "Alignment" has a small peculiarity, however.

Positions the text at the lower edge of the screen.
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The text will be displayed in the center of the screen.

Positions the text at the upper edge of the screen.

Detaches the text to be able to customize its position.

The text will be displayed underneath the image. This also applies when the image is
scaled smaller.

Enter the desired image caption into the text field. Specify font and font size. If you want colored
text you can change the font color. Select the position of the text. If you want a customized text

position click the -button under "Alignment". All changes are immediately visible in "Layout
designer". In the customized position the texts gets its own position frame. This way you can
freely place the text anywhere on the screen.

In AquaSoft ® SlideShow you can decide if you want the text to be separately animated or to be
part of the transition effect of the image it accompanies .

If you don't want a separate text animation please activate the option "Show text with image".

For text that you want to be animated you can choose from a list of pre-defined animations. Click
the "Edit" -button to adjust the settings for the animation. You can also see a preview of the
animation in this dialog.
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You can also open this dialog by clicking on an image in the "Image list" or "Timeline"
and then on "Select text animation".

Under "Fade out" you can specify if you want the text to stay visible until the end of the image
duration and to be included into the transition to the next image or if the text fades out at the end of
the image. The duration of the animation specifies when the fade-out is to be started.

If you set 3 seconds then the fade-out starts 3 seconds before the end of the image display.

By clicking the -button you can save the text effect settings you just selected. They will then
be stored in the "Toolbox" under "Text effects" and can be reused at any time. Saving text
effects is only possible with AquaSoft SlideShow Studio.

After you finished all the adjustments you can then replay the image together with the text by

clicking on .

You can find all pre-defined "Text effects" in the "Toolbox" as well. Sie können diese einfach per
Drag&Drop, als durch Ziehen mit gedrückter Maustaste, auf ein Bild anwenden.

Klicken Sie einen „Texteffekt“ an, so erhalten Sie eine Vorschau.
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As described above, you can enter and format text on the "Text" -tab in the "Object settings".

3.3.2 Text without an image

In the “Toolbox” under “SlideShow objects” there is the “Colored background”. With this you
can fade in text independently of images. The “Colored background” can even be faded in
animated.

To insert it, double-click the “Colored background” or drag the object into the “Image List” or
onto the “Timeline” with the mouse button pressed down.

When inserting it with the mouse button pressed down, you can also determine the
desired position on the “Timeline” and in the “Image List”. Should you wish to add
the “Colored background” between two images, drag the object to the desired place
with the mouse.

The “Colored background” is shown on the “Timeline” as a white image. In the “Image List” it
is listed as “white1x1.png”.

The text can now be entered as with a normal image.

On the “Timeline”, click the object with the right mouse button and select “Select text
animation”.

Now the “Edit text animation” window opens. There you can enter the desired text and select
and edit a corresponding animation.
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Under “Fade out” you can determine whether the text should remain visible until the end of the
image and should be cross faded with the next image, or whether the text should be faded out
prior to the end of the image. In this respect, the duration of the animation determines when the
fading out should begin.

Should you set 3 seconds, the fading out is started 3 seconds before the image finishes.

With "OK" your entries are accepted and you can use   play back the text animation on the
screen.

The background is now shown in black. If you wish to have a different color, you can do this in the 
“Object settings” of the “Colored background”. For that purpose, you have to click the object in
the “Image List” or on the “Timeline”. Should the “Object settings” not be shown in the view
available to you, you can also retrieve them by right-clicking the object.
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By clicking the selected button you can change the background color.

You can also have the colored background faded in animated. Under “Transitions” you can
select a cross fading effect.

Under „Text“ you can carry out the formatting of the text, as well as change the color of the font.
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Should the text not be faded in animated, but together with the colored background, check the 
“Show text with image” option.

The “Colored background” can also be used to dim out/fade out images. Should a
black background color be set and a cross fading effect selected, it has the effect on
the observer of a fading out of the previous image. In this way you can end a slide show
in style.

3.3.3 Rotating text

Adding texts to images or a colored background has been described in previous chapters. This
chapter is about their rotation functionality.

This feature is only available in AquaSoft ® SlideShow Studio.

First add a text to an image. This should look similar to the following graphic in "Layout designer"
.
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Please note the "green handle" above the text. You can use it to rotate the text. Click the handle,
hold down the mouse button and move the mouse in a rotating motion.

The number next to the green handle shows by how many degrees the text has been rotated.

You can find more information about the use of rotated text in chapter „Letting texts fly“.
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3.3.4 Multiple texts

In AquaSoft ® SlideShow there is also the possibility of fading in multiple texts either
simultaneously or with a time delay.

In the “Toolbox” there is the “text” object for this purpose.

Fading in multiple texts, in sequence

In this example 3 texts to an image appear, in sequence. The number of possible texts is not
limited.

Insert an image. Using the “Toolbox”, now add 3 “Text” objects. You can do this with a
double-click or by means of drag-and-drop (dragging with the mouse) into the “Image List” or
onto the “Timeline”. 

Now select the first “Text” object. In that respect, it does not matter whether you click it in the
“Image List” or on the “Timeline”.

In the “Object settings” of the “Text” object, you can now enter your desired text and carry out
the formatting. Position the text in the “Layout Designer”.
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Select an animation and then call the editing function of the text effect via “Edit”.

So that the text is not faded out again before the next text is shown, the “No fade out” option
must be set under “Fade out”.

You can also have the text faded out if it is no longer supposed to be visible when the subsequent
text is displayed.

Now repeat the steps with the second and third “Text” object.

Then play back the little show with .
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In the “Object settings” of the “Text” objects you can change the holding time of the texts.

Showing multiple texts simultaneously

In order to now not show the texts in sequence, but simultaneously, the “Chapter” object is
required. Use the little show that you have just created.

Add the “Chapter” object into your show.
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The “Chapter” can have several tracks and therefore show the “SlideShow objects” in
parallel/simultaneously.

Click on the image on the “Timeline”
and drag it with the mouse button
pressed down to the “Chapter” object.
The “Chapter” is framed in red if you
go over it with the mouse. If this red
frame appears, "drop" the image.

After that it looks like this on the 
“Timeline”. You now have to open
the “Chapter”. There is a little plus
symbol for that.

Now drag the first “Text” object into
the “Chapter”. Drag it to underneath
the image in the “Chapter”. A red
vertical bar will appear if you move the
mouse to the correct position.

Now drag the first “Text” object into
the “Chapter”. Drag it to underneath
the image in the “Chapter”. 

If you now drag the “Timeline” to
make it larger, it must look like in the
illustration.

Now play back the show again with

. You will see that the image and
the texts are all faded in
simultaneously.

Using the “Timeline” you can adapt
the timing individually. For this, you
can simply drag the “Text” objects
with the mouse into the starting
position.
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When you don't work on a chapter you
can close it by clicking the minus
symbol.

3.3.5 Letting texts fly

The “Text” objects which you have already become acquainted with in the previous section can
also be animated with a movement path. In other words, they can "fly" across the image.

For this purpose, the “Layout Designer” provides the necessary tools.

Insert an “Image” and a “Text” object into your show.

Then click the “text” in the “Image List” or on the “Timeline”. In the “Layout Designer” the
tools for the movement path are now enabled.

This is the icon for switching, in the “Layout Designer”, into the mode
for movement paths. There is yet another mode for camera pans and
zoom. Since this function is not available with the "Text” object, the
icon for the movement path mode is active.
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Use this button to insert new “movement markers”. The course of the
movement is established on the basis of these points.

In order to remove “movement markers” that have been set, the latter
must be selected in the “Layout Designer” and can then be removed
with this button.

In this respect, an additional menu for the “movement markers” is
opened. This is explained more precisely later on. 

The chronological course of a path is established with timestamps.
They thereby determine how quickly the sequence should occur. That
is clarified in an example below.

Newly created movement paths can be saved using this button and
later conveniently reused. This function is only available in SlideShow
Studio.

Inserting a movement marker

Insert a “movement marker” by means of .

Positioning a movement marker
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You can now drag the “movement marker” inserted in the “Layout Designer”. For that
purpose you have to click in the text area and then drag the latter with the mouse button
pressed down.

The orange dot shows you which “movement marker” has been selected

Now you can replay the show by clicking  and watch how the text moves.

Chronological sequence

With “Timestamp” you can control the sequence. If you increase the time, the sequence
becomes slower. If you reduce the time, the sequence becomes faster.

First increase the “Timestamp” of the movement point and then replay the show.
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Starting time

If the movement sequence is only supposed to begin after a time delay, you can increase the 
“Timestamp” with the first “movement marker”. For that purpose, click the “movement
marker” and then increase the time unit. The subsequent movement markers will
automatically be adapted.

Inserting further movement markers

You can insert as many “Movement markers” as you like. The new „movement marker“ is
always inserted behind the marker selected.
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Select the last “movement marker” and with  insert a new marker and position it in the
“Layout Designer”.

Play back the show. You will find that the last part of the movement path elapses faster than
the first part. You can control this for the 3rd movement point via the “Timestamp”.

Hard and soft curves

In the course of movement you can choose between “hard” and “soft” curves. With “Hard
curves” the path will run exactly in accordance with the movement points. With “Soft
curves” a round course of movement will take place. You can use both “curve types” within
one path.

Mark a movement point. Via the right mouse button you will get the menu for this movement
marker and can change the “Curve Type” there.

With all 3 points change the “Curve Type”.
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You will see that the “movement markers” now have a rectangular marking point. With “Soft
curves” these points are round.

In order to see the change in the path, play back the show.

Rotating text during movement sequence

In SlideShow Studio you can rotate or swing texts during a movements sequence also.

For this purpose there is a green handle above the „Text“ field. More extensive information about
the rotation functionality for „Text“ you can find here.

First rotate the text at the first and second movement markers. Rotations through 360 degrees are
also possible, to create complete rotation.
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Play back the show. You will see that the rotation center is, in this respect, the midpoint of the text
box. Should the rotation center be the center of the text, in the “Text” properties enable the
“Rotation in the center of the text” function.

Letting the text fly in from outside

There are two areas in the Layout Designer. Firstly the visible area, and then the invisible area.
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Enlarges the visible area in the Layout Designer.

Reduces the visible area in the Layout Designer.

Restores the normal view/window size.

Continue to use the show just created. 

Reduce the visible area with  in order to see the invisible area in the “Layout Designer”.

Now select the first movement marker and drag it into the “invisible area”.
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Starten Sie das Abspielen der Show. Der „Text“ fliegt nun von außen in das Bild hinein.

Zoom function for text

Just like rotation, this function is only available in SlideShow Studio.

Traveling along a movement path „Text“ can increase and decrease in size. The smallest size is
defined by its specified font size.

Select the 2nd movement mark and increase the size of the "position frame" of the „Text“-field.

Start to play back the show. The “Text” will now fly into the image from outside.

Further options

Via  the context menu for the movement markers can be opened. With a right-click on a
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marked movement point, this menu can likewise be opened.

Some options have already been used above. The following further options are available:

A movement path already created can be copied and thus
re-used with a slide show object. If you copy a movement path
from a text object, this can also be inserted in the case of an
image.

With this option, you re-insert a copied path from the clipboard.

If you want to be sure that the text or the image does not change
size in the course of your movement path, you can set the “Use
the size from the previous one” option here. 

There are hard and soft curves with a movement path. The
course of a movement can thereby be modified.

A movement path can also be mirrored or rotated. You will find
the available options under this point.

A movement path can also be mirrored or rotated. You will find
the available options under this point.

With this all movement markers can be selected. Thereafter it is
possible to drag the movement path as a whole.

Manually entering the path

Manually entering the path enables the movement points to be positioned exactly.
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The “Layout Designer” is specified with a size of 1000x1000. The center of the image is
therefore 500x500. Here you can directly specify the positions and sizes. You can also change
between the individual markers in this window.

3.4 Multiple tracks

In AquaSoft ® SlideShow at first glance you only see an image and music track on the
“Timeline”. This serves to provide a better overview. At positions where you require multiple
tracks, the “Chapter” object is used.

With this you can connect as many tracks as you want. In that respect, it is not predetermined
which objects can contain a track. Therefore you can place images, music or texts on any track.

You will find the “Chapter” object in the “Toolbox” under “SlideShow objects”.

The “Chapter” can be inserted by double-clicking. You can, however, also drag it to the desired
position on the “Timeline” or in the “Image List” with the mouse button pressed down.

Insert a few images and a “chapter” into an empty show.

The “chapter” is inserted empty. You will then have to move the desired objects into the chapter.
You can do that on the “Timeline” or in the “Image List” or “Storyboard”. Click on an image
and then drag it with the mouse button pressed down to the “chapter”.
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If you go over the “chapter” with the mouse, the “chapter” is framed in red on the “Timeline”.
Let go of the image there.

The “chapter” now contains a small “plus” icon.

This shows that the objects are to be found in this “chapter”. By clicking the “plus” icon you can
open the “chapter”.

The red bar under the first image determines the starting position of the image. The image is
inserted at this point.
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The reference to a new track now appears under the second image. You can place as many
objects as you wish on each track. In that respect, the red bar helps you to insert the objects in the
correct position.

You can also insert “SlideShow objects” into a “chapter” directly from the “Toolbox”. First of
all drag a “Text” object onto a new track.
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You can change the positions within the “chapter” by dragging the objects with the mouse. By
clicking dragging the beginning and the end of an object, the “Exposure time/Holding time” of an
object can be changed.

The objects within a chapter behaviour in a similar way to a pack of cards. In other words,
the object on the lowest track is arranged on top of the other objects. In this example, the
text is shown on all 3 images. Should the text stand on the first track, it would be covered
up by the images.

Example:

Often we are asked how “Track/Sound” is set for only a few images. The background music
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should be faded out at this point, but not interrupted. 

Insert a few “images” into an empty show and a “chapter”.

Then move the images into the “chapter”. In that respect, the images should all be on one track.

Now drag a “Sound” object from the “Toolbox” onto the 2nd track in the “chapter” in exactly the
same way as the “Text” object was inserted into the “chapter” above.
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You can add “Background music” by clicking the corresponding track in the “Timeline”. Using
the “plus” icon, you can insert the track.

The track is then shown on the “Background music track” of the “Timeline”.

The “Object settings” of the “Sound” object should be displayed in the “Object settings”
window. If not, select the “Sound” object on the “Timeline” by clicking it with the mouse.

Should the playback length of the sounds be too long for you, you can reduce it. The relevant
settings are marked in red in the illustration below.
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On the “Timeline” you will now see that the “Sound” fits in with the 5 images exactly. The
“Background music” is cancelled during this period of time. If you insert yet more images behind
the “chapter”, you will see how the “background music track” is continued.

“Images”, “texts” and “sounds” can be combined in a “chapter” as desired.
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The “Chapter” has a “minus” icon at the top on the left if it is open. You can close it by that
means if you are no longer working on this “chapter”. That increases the clarity in a substantial
show.

By utilizing SlideShow-Manager 6 you can create a menu for your show where you can
jump to these chapters directly. SlideShow-Manager 6 is already included in SlideShow
Studio. You can also add it as plug-in to SlideShow Deluxe.

3.5 Ken Burns Effect

You will find an example of the Ken Burns effect in the sample slide shows supplied with the
software. 

In AquaSoft ® SlideShow you can quite simply apply this effect to your images.

Insert a few images into an empty slide show. In the “Toolbox” you will find the “Ken Burns
effect” under “Movement paths”.

To apply it to an image, simply drag the effect out of the “Toolbox” onto the corresponding image.

There are 4 variations of this effect. Apply the “Ken Burns effect” to all images.

Then select all images in the “Image List” with “Ctrl” + “A”. For that purpose, you have to first
click an image in the “Image List”.

Now select “Alphablending” as “Transition” in the “Image Object settings”. The “Fill



55Design options in AquaSoft ® SlideShow

Copyright © AquaSoft GmbH 1999-2010

background” function has to be enabled as well.

Then play back the show with .

You notice that the transitions could be a little „smoother“. This can be accomplished by using a
“Chapter“. Add a “Chapter“ to the show. Move the „Images“ into the “Chapter“ and arrange
the images in a stair shape. The start of an image needs to be moved slightly underneath the end
of the previous one.

Then play back the show with .
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The “Ken Burns effect” is implemented by means of a “camera pan”. You can also change this
individually. For that purpose, you have to change in the “Layout Designer” to the “Camera pan”

mode. To do that, click   in the “Layout Designer”.

The “movement path” is now shown in the “Layout Designer”. How quickly or slowly a
movement progresses is determined by means of the time set to the 2nd movement point. The
greater the time, the more slowly the movement is carried out. 

In order to change the time and thus the sequence, click the 2nd movement marker in the “Layout
Designer”. The movement marker with “0.0 s” is the first movement point and therefore the
starting position. After you have marked the 2nd marker, you can change the time set via the
image under “Timestamp”. A selected movement marker is shown in the “Layout Designer” in
orange.

When using a „Ken Burns Effect“ only a part of the image section is used at the first movement
mark. You will notice the smaller “Position frame“. Only during the “Camera pan“ will the full
image section become visible. Therefore, the “Position frame“ is larger at the second movement
mark. 

You will find more about movement path in the chapters „Movements“ and „Zoom“.

3.6 Adding videos

You can not only use images in AquaSoft ® SlideShow, but you can also insert videos.

In principle, all video formats which can be played back in Windows Media Player are supported.
Should it not be possible to play back your video in Windows Media Player, the problem could be a
missing DirectShow filter for the video format. This can partially be installed afterwards. There are
different codec and filter packages available for download, e.g. the „K-Lite Mega Codec Pack“
on Chip online. Please read the information to the codec pack and contact the author of the
package if necessary. The installation of codecs can also affect other programs.

To insert a video, you will find the the “Video” object in the “Toolbox” under “SlideShow
objects”.

http://www.chip.de/downloads/K-Lite-Mega-Codec-Pack_23300451.html
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You can insert it with a double-click or drag the “Video” object with the mouse out of the
“Toolbox” onto the “Timeline” or “Storyboard” or into the“Image List”.

In the “Object settings” of the video you now have various setting options. Should the “Object
settings” not be shown in the view available to you, you can retrieve them by right-clicking the
video on the “Timeline” or in the “Image List”.

Should the full length of the video not be played back, remove the check mark beside “Play back
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the full length of the video”. You can then determine the playback duration individually. 

Should the “video” not be intended to be played back full screen size, it can be freely positioned in
the “Layout Designer”. You can also assign a cross fading effect to the video.

The “Fill background” function enables you to see the previous image during playback of the
video or cover it up with a colored background.

Under “Sound” you can determine whether the background music is supposed to be faded out
during the course of the video being played. Should you have your own audio or spoken
commentaries in the video, you should use this function.

Further “Object settings” of the video are explained here.

The “video” can also be animated with a movement path. How that functions exactly you can find
out here.

3.7 Collage

In only a few steps, you can create beautiful collages.

Double-click the “Collage” object from the “Toolbox”.

In this way a “collage” is inserted into your slide show. Click this “collage" in the “Image List” or
on the “Timeline” and you will see in the “Layout Designer” that the “collage” is empty at the
moment. In order to fill it in, just double-click the “Image” object from the “Toolbox”. 

In the dialog which now appears, simply select all images to be used for your collage.

These are inserted into the collage, since they were selected in the “Image List” and on the
“Timeline”. If you click  next to the “collage”, you can view all images in the “collage”.
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Now simply click on the individual images and drag/maximize/minimize them as you please, until
you are happy with the result. You can reduce the images using the “positioning framework” in
the “Layout Designer”.

Now insert a “Text” from the “Toolbox” and position it as you please.

If the “Text” is not inserted into the “Collage” now, the collage was probably not
selected when you inserted the “Text”. Click and simply drag the “Text” onto the
“Collage” and release the mouse button. This works in the “Image List”, on the
“Timeline” and on the “Storyboard”.
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Now you have a finished “collage”, consisting of your “images” and a “text”. The images can
also overlap. Likewise you can create an “image within image” effect by not reducing the size of
the first image.

If you select the “Collage” object, you can change “Object settings” of the “collage”. You can
determine a “transition” and change the exposure time.

All “images” and “texts” within a “collage” are not independently animated. For this you need
the “Chapter” object.

As you can see, putting together a decent collage is achieved quickly and easily.
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As in an “image”, in a “collage” you can zoom and furnish this with a “camera pan”.
Simply try it out.

You will find more about movement path in the chapters „Movements“ and „Zoom“.

3.8 Movements

You already learned about “movement paths” in chapter „Text animations“.

You can apply “movement paths” to the following “SlideShow objects”:

Insert an “image” which you would like to animate with a “movement path”.

Then click on the “image” in the “Image List” or on the “Timeline”. In the “Layout Designer”
the tools for the movement path are now activated.

This is the icon for switching, in the “Layout Designer”, into the mode
for movement paths.

Using this icon, switch into the mode for camera pans and zoom.

Use this button to insert new “movement markers”. The course of the
movement is established on the basis of these points.

To remove “movement markers” that have been set, the latter must
be selected in the “Layout Designer” and can then be removed with
this button.

You can use this to open a further menu for the “movement markers”.
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The chronological course of a path is established with timestamps. You
can thereby determine how quickly the sequence should occur. That is
clarified in an example below.

You custom movement paths can be saved and reused. This function
is only available in SlideShow Studio.

3.8.1 Simple movement shots

Your images learn to walk. With a few clicks your images wander over the screen. Simply follow
these instructions and you will be quickly and comfortably introduced to the colorful, moving world
of AquaSoft ® SlideShow.

Create a new slide show  and insert an “image”.

Click on the “image” in the “Image List” or on the “Timeline”, so that the “image” is displayed
in the “Layout Designer”.

In this example we would like to explain how you can arrange for an image to “fly onto” the screen

from “outside”. For that purpose, we have to enlarge the invisible area with .
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Now move the image into the invisible area.

Now insert a new movement marker with . Then move the newly inserted movement marker
into the visible area.
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Play back the show. You will see that the image now "flies onto" the screen from the top left-hand
corner. Increase the timestamp at the 2nd movement marker and movement becomes slower.

In order to be sure that the image arrives in the center of the screen and also the size of the image

is not changed, retrieve the “Manual entry” once via .

Select “Marker 2” and enter 500/500 in the center Also set the “Size of previous item”. so that
the size of the image is not accidentally altered during the path.

The “manual entry” assumes a system of co-ordinates in which the “Layout Designer” is
1000x1000 units wide. Therefore, in order to center our image, enter 500 at X (the horizontal
position of the midpoint) and at Y (the vertical position of the midpoint), i.e. half of the respective
total extent. You can also use negative numbers. These then refer to the “invisible area”.
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3.8.2 Movements with alterations in size

Images grow

The image with the path set from the previous section also has to be modified slightly.

You should see it like this in the “Layout Designer”:

Now open “Custom entry” using the  icon.

Select the 2nd marker and change the setting under “Size” to “Freely adjustable”.

Then close “Custom entry”. It is possible to also carry out the next step from this menu, however
we are choosing the “Layout Designer” directly.

Using the “positioning framework”, reduce the image at the first marker, i.e. the marker which is
outside the visible area. Then move the marker closer to the visible area.



66 AquaSoft SlideShow - Help

Copyright © AquaSoft GmbH 1999-2010

Now play back the show and you will see that the image is larger when it is in motion.

You can select a “Transition”, or also "None", in the “Object settings” of the “image”. 

First of all, position the first marker in the visible area. Then restore the “Layout Designer” to

“Normal view”. with .
Then access “Custom entry”.

First of all set the values shown in the image. In the “Object settings” of the image select a
“Transition”. Afterwards play back the effect. 

Now the image should “fly” back to its original position. For this, two additional “movement
markers” are required. Click the 2nd marker in the “Layout Designer” and then insert an

additional movement marker with .
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This marker is required to allow the image to stand still. The image should not become smaller
again immediately. In this case a movement marker can be directly laid over a previous marker. To
do that, you only now have to drag Marker 3 over the top of Marker 2.

Then increase the time at the 3rd marker, as given in the image above. Then insert a 4th marker

with   . You will not recognise this immediately, since it is inserted exactly over the top of the
2nd and 3rd markers. 

Retrieve “Custom entry” via  .
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Now, under “center” and “size” set the values which have already been used at the first marker.

If you now play back the show, you will see that the image is enlarged and then reverts to its
original place.

Now insert a new image into the show. Click on our image above once more and access the

context menu via  . There select “Copy path”. Now mark the newly inserted image and

access the context menu again via  and this time select “Insert path”.

In the “Object settings” of the 2nd image you have to disable the “Fill background” function.

Now we will for once change the positions of the first and last markers. To do that, access the

context menu via   and accept the settings below once.
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Marker 1:

Marker 4:

Then play back the show once in its entirety. And how do you like the effect?

In SlideShow Studio you can use “Rotations“. This is easy to accomplish via “Custom entry”,
too.

Open the context menu for an image via  and select the 2nd movement marker. Under
“Rotation“ set the angle to 360 degrees. Do the same with the 3rd movement marker.
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Play back the show.

These “movement paths“ can be used on the following “Slideshow objects“:
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3.8.3 Camera pans

Create a new slide show  and insert an "image”.

Click on it in the “Image List” or on the “Timeline”, so that the image is shown in the “Layout
Designer” and the corresponding tools are enabled.

With camera pans the images must be enlarged beyond the visible area. For that purpose, reduce

the display of the visible area with the  icon.
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Now enlarge the image using the “positioning frame” until it looks similar to the image below.

Then, with the  insert a new movement marker and position it to the left of the first movement
marker.
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Increase the time at the second movement marker, so that the movement is carried out more
slowly. Should you not wish to have any “Transition” at the beginning of the movement path, you
can set “None” in the “Object settings” of the image.

Then, with the right mouse button, retrieve the context menu at the 2nd movement marker
marked. Now, in the latter, select “Position frame”/“Use size of previous item”. As a result, the
size of the second movement marker is automatically adapted to the size of the previous one and
can no longer be changed accidentally.

Every image with the setting “Use size of previous item” is marked in the “Layout

Designer” by a  .

Now simply click  and enjoy the effect.
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3.9 Zoom

With AquaSoft ® SlideShow you can also zoom into your images. If you want to show a particular
section of an image enlarged, you can generate this using the corresponding tools in the “Layout
Designer”. In that respect, you can freely choose the area which you would like to zoom in on.

You can apply “Zoom” and “Camera pans” to the “SlideShow objects” below:

You might find it useful to skim through the movements tutorial first since the zoom function is
based on the movement path system.

Zooming into an image easily

Create a new slide show  and insert an image.

Click on the “image” in the “Image List” or on the “Timeline”, so that the image is shown in the
“Layout Designer” and the corresponding tools are enabled.

Select the   icon from the upper edge of the “Layout Designer” to enter the “Camera pan
mode”.
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Now click the  icon. This inserts a movement marker. A “position frame” is now drawn
around this additional marker. Reduce the size of this marker by means of the “position frame”
and drag the section to the place which is supposed to be enlarged.

So that the “Transition” does not have a disturbing effect on the “Zoom”, you can set the
“Transition” in the “Object settings” of the image to “None” or increase the “Timestamps”.

The 2nd marker is still marked (orange). First of all set the time there at 4 seconds. Then click the
first marker in the “Layout Designer” and set the value to 3 seconds or more.

You can see that, by changing the time of the first marker, the subsequent markers also change
automatically. In this way the movement set remains unchanged within the path.

The exposure time of an image is increased automatically if the time of the movement
path becomes greater than the “Duration” set in the “Image Object settings”.

After clicking  you can play back the zoom effect.
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Motion in the image

If you would like to zoom in on several sections of an image, you can now use a movement path in
the image. Imagine you have a group photo and now wish to zoom in on the individual persons.
However, you do not wish to constantly zoom in and out, but go over the faces in the image.

For that purpose, you can now insert an additional movement marker with the  icon. Position
the marker at the desired final point.

If you now play back the effect, you will now see that a camera pan is possible within the image.
Using the time of the last movement marker you can control the speed. If you increase the time,
the shot becomes slower.

Zooming out

You can have the image cross faded while you are zoomed in on the section, or first revert back to
the overall image size.

In order to revert back to the full size, insert a new movement marker. Please ensure that the last
movement marker is selected.
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The easiest thing to do is now to use the “custom entry”. Retrieve this via the right mouse button

or via the  icon.

At “Marker 4” set 500/500 as the “Center” and 1000/1000 under "Size” . As a result, the image
at Marker 4 is displayed completely, again.

Now simply click  and enjoy the effect.

If you would like to leave the image at the end exposed a bit longer, increase the 
“Exposure time” of the image from the “Object settings”. After the end of the
movement path, the image then continues to remain on the screen.
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When aligning the movement markers, it may occur to you that they snap magnetically
to other movement markers and to horizontal and vertical lines of other movement
markers. You can prevent them snapping this way by holding down the “Ctrl” key on
the keyboard when moving the marker.

Furthermore, the movement markers are also aligned to the grid which can be enabled

using the  icon.

As you can see, it is very easy to zoom images. Simply insert movement markers and position
them as desired – and already motions enters your image.

The movement path can be changed using the “Curve type”. Select “Select all markers” by

means of the  icon and click in the “Layout Designer” with the right mouse button.

In the context menu which now appears, select “Curve type”/“Hard”.

You will now see the change in the form of the movement marker. This is now square, in order to
represent the “curve type” chosen.

After clicking  you can see the change in the zoom. The pan in the curves is now “Hard”
and is no longer carried out soft.

3.10 Rotations

Just camera pans are not enough for you? You want more zest in your slide show? Add freely
definable rotations to your images.

This feature is only available in AquaSoft ® SlideShow Studio.
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The following objects can be rotated:

It doesn't hurt to read the tutorial Movements first because the rotations are combined with
movement paths. The chapters Rotating text and Letting texts fly give more information about
rotating text.

Create a new slide show  and add an image.

Select the image in "Image list" or "Timeline" to display it in "Layout designer". The use the

 button in "Layout designer" to zoom out a little.

Now you can use the green handle to rotate the image. Click it, hold the mouse button down and
define the rotation angle. Use the "Position frame" around the image to decrease its size.
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The gray/white area in "Layout designer" is the visible area. Images need to be
positioned in this area if you want them to be displayed. You need the outside area for
special purposes like e.g. images or texts that "fly" in from the outside.

To manually specify the rotation angle click on the image in "Layout designer" and select
"Custom entry".

Now enter the "angle" under "Rotation".

Beautify your Collages by rotating the images in the Collage. Texts can be rotated this way, as
well.

Of course this is not all you can accomplish with the rotation functionality. Would you like to trace
your travel route with a car on a map? Then you can learn now how to combine movement marks
with rotations.

In our example we let the car follow a road. First we add the image of the road using the 
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button. Instead you can add your image of the map.

Now we need the car. Preferably it should be a PNG graphic with alpha channel.

Please consult the FAQ about how to create this type of graphic.

Add the car.

Decrease the size of the image using the "Position frame".

http://forum.aquasoft.de/index.php?c=6
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Now you can start the tour. Add a movement mark  and rotate the car a little, following the
direction of the road.

Add more movement marks and rotate the car accordingly.

You can adjust the time marks for each movement mark individually. Click on a mark, it will then
be highlighted. Change the time mark in the menu bar above the image.

Now replay your show via .

Eventually the complete movement path should look similar to the following graphic.
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The "rotation angle" can be larger than 360 degrees. This way you can simulate effects
like the skidding of a car out of a curve.

3.11 Image effects

With AquaSoft ® SlideShow you can now also apply image effects to your images and in this way
present your images even more impressively.

In the “Toolbox” you will find the “Image effects”.

The “Image effects” are subdivided into various categories. With the “plus” icon you can open
up the individual categories.
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The “image effects” can be applied to an image very easily. Insert a few images into an empty
slide show.

In order to now be able to apply the “image effects” to these images, simply drag the desired
effect out of the “Toolbox” onto the image onto the “Timeline”.

You will see the change in the “Layout Designer”. The effect becomes properly visible when
playing back.

If you want to remove an “image effect” again, in the category “Common” you will find the
“Delete all image effects” object in the “Image effects”.

Simply drag the latter from the “Toolbox” onto the image on the “Timeline” in the case of which
you wish to remove an effect set.

In AquaSoft ® SlideShow Studio you can create and edit such effects yourself. A special  Dort
gibt es einen speziellen “Effect editor” is available. It is explained in chapter Image editing.
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3.12 Animated transparency

In AquaSoft ® SlideShow a transparency behaviour can be assigned to some “SlideShow
objects”. In this way images and texts can also appear semi-transparent on a previous image.

You can apply the “animated transparency” to the “SlideShow objects” below:

You will find the corresponding possibility for setting them in the “Object settings” of the
respective “SlideShow objects”.

Now with the left mouse button set markers in this system, which then form a transparency curve.
On the left-hand side you will find the value of the transparency (in %); at 100% transparency the
image is completely transparent (i.e. no longer recognizable), at 0% it can be seen completely.
Above the curve you will find icons, the meaning of which is:

Points are round, the course of the transparency animation is soft.

Points are square, the course of the transparency animation is hard.

If you have clicked a transparency marker (appears orange), you can delete the marker
by clicking the icon.
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If you have changed the exposure time of the image or text, you can, by clicking this
button, have the transparency set adjusted to the exposure time.

Move the markers by clicking an existing marker and keeping the mouse button pressed down.
Now simply move the marker to the desired spot and release the button again. In order to delete
the animated transparency entirely, you will have to remove all transparency markers.

3.13 Background music

A perfect slide show not only includes impressive effects, but also the background music. For the 
“background music” the “Timeline” provides its own sound track.

Click this sound track and the “Background music” menu is opened.

By means of the plus icon  you can insert music onto that menu. 

If you click the song, you can make further adjustments.
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You can insert one or also multiple tracks. These are then listed below one another in the
list. You can change the sequence by clicking the track and moving it in the list with the
mouse button pressed down.

Removes a selected track from the list

Plays back a selected song

Opens the music settings

A track can be gently faded in. In this case state how
many second the fading in should last until the full
volume should be achieved.

Songs can also be gently faded out. In other words, they
are getting more and more quiet prior to the end. Here
set the time, how long prior to the end the fading out
should start.

Specify here at what volume the track should be played
back.

You can delay the start of a track. Specify here the length
of the delay.

If you do not want the following track to begin
immediately, specify here the length of the break
between songs.

It is also possible to only play a section of a track. Here
you determine from what point in the song playing should
start. For example, 20 secs -> The song begins at the
20th second. The first 20 seconds of the song are not
played.
0 -> From the beginning.



88 AquaSoft SlideShow - Help

Copyright © AquaSoft GmbH 1999-2010

Here you can determine when the song should end. In
that respect, the timestamp in the song is to be selected
again. If you want to end the song after 2 minutes, enter
120 secs here.

Example: Starting and final positions

You wish to only play 1 minute of the song. However, the part of the song which you would like to
play back begins at the 45th second.

Starting position = 45 secs

Final position = 105 secs

Only use unencrypted music tracks for your slide shows. For legal reasons, AquaSoft ®
SlideShow does not support the use of music tracks which have been encrypted by
DRM or similar procedures.

The volume of the background music can be set individually.

3.14 Sound objects

If you have undertaken the desired adjustments with an object/image, you can drag it out of the 
“Image List” or “Timeline” to the “Toolbox”. A window then opens for saving the template.
Enter a name there.

Afterwards you will find the template in the “Toolbox” under “SlideShow objects” -> “My
Objects”. Click the object and then select the images. These are then inserted with the desired
template.

The „Sound“-object is usually used if a sound will only be played over the length of a certain
number of images. This is accomplished by using a “Chapter”. You can find an example in
chapter Multiple tracks.

Here you can find a chapter about „Sound“-properties.

Only use unencrypted music tracks for your slide shows. For legal reasons, AquaSoft ®
SlideShow does not support the use of music tracks which have been encrypted by
DRM or similar procedures.
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3.15 Saving own templates

If you have undertaken the desired adjustments with an object/image, you can drag it out of the 
“Image List” or “Timeline” to the “Toolbox”. A window then opens for saving the template.
Enter a name there.

Afterwards you will find the template in the “Toolbox” under “SlideShow objects” -> “My
Objects”. Click the object and then select the images. These are then inserted with the desired
template.

3.16 Using the SlideShow-Master

The SlideShow Master contains a series of slide show templates which make it easy for you to
create a slide show.

At lightning speed you can select images and music to create an attractive slide show in
connection with a style.

Under “File” -> “New” -> “Use SlideShow Master” you can access the “SlideShow Master”.
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Click “Next” to begin designing the slide show.

In the next step please insert images using the “plus” icon.

Then click “Next”.

Now insert your desired background music using the “plus” icon.
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Soll die Abspieldauer nicht an die Hintergrundmusik angepasst werden, so entfernen
Sie den Haken bei der Option. Bei gesetztem Häkchen wird die Verweildauer der
Bilder der Länge der Musik angepasst. 

Next click “Next”.

Now select a style template.

With the “Start preview” button you can inspect the style template.

With some templates you can enter a film title and further personal details. For that
purpose, simply click the personalization data directly and enter your desired text.



92 AquaSoft SlideShow - Help

Copyright © AquaSoft GmbH 1999-2010

Then click “Next”.

Now you can decide what the next step should be.

Edit slide show: Opens the style template with the images in AquaSoft ®
SlideShow for editing. It is now possible to make individual
adjustments.

PC DiaShow auf CD brennen: This option opens the CD Wizard and you can record the
show on a CD or prepare it for passing on. The CD recorded
can then be reproduced on a PC (not on a DVD player).

Video auf VCD, SVCD oder
DVD brennen:

This option opens the Video Wizard. With this the slide show
is recorded on a video CD or DVD. First the show must be
converted into a video.

4 Properties of slide show objects

As you have already learnt in the previous sections, there are so-called “Object settings” for the
“SlideShow objects”. In these you can configure specific settings for the respective objects.

You will find the “SlideShow objects” in the “Toolbox”.
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The “Object settings” can be shown fixed on the user interface (always embedded) or also only
displayed when required. If you do not show them on the user interface, you can access the 
“Object settings” at any time by “right-clicking” the relevant object.

The following fundamental properties are available with every object:

Determines whether the object should be shown when
playing back the slide show.

Here you can set the exposure time. In other words, how
long, for example, an image, text or video is supposed to be
shown. The cross fading effects take place within this
exposure time.

In the “SlideShow settings” you can set a standard
exposure time for your “SlideShow objects”. If you change
the exposure time there, this applies to all “SlideShow
objects” in the show in the case of which the standard
exposure time was enabled and to “SlideShow objects”
which are newly inserted.

Normally an image or text is cross faded by a subsequent
image. In that respect, the image “lingers”. If it is not desired
in the case of a particular animation, the “lingering” can also
be turned off.
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4.1 Image

In the “Object settings” of an “Image” you can configure the following settings:

Image

File name Shows the path and file name of your image.

Aspect ratio Images have an aspect ratio which is comprised of the
height and width of the image. If an image differs from
the aspect ratio of the slide show set, it can be decided
here how the image should be represented.

Retain: The image retains outlines when being played
back.

Crop: Parts are “cropped” from the edge of the image
until the image fits into the correct aspect ratio without
edges emerging.
Distort: The image is inserted into the aspect ratio of the
slide show, whereby a distortion of the image takes
place.

Alignment Determines the position of the image on the screen.

Fill background The background is always filled if the image is reduced in
size or the image differs from the slide show aspect ratio
set. It can then occur that the previous image “shines
through”. This can be prevented by means of this
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function. The color used for filling the background can be
changed at your option. In the case of “image within
image” effects, the function must be deselected.

Transition Here the “Transition” can be set or also deselected. For
that purpose, in the drop-down list there is “None” as the
first option. With the “Adjust” button, the transitions can
be configured. You can also obtain a preview of all
transitions there.

Text

The possible formats are almost always self-explanatory through the icons and you are no doubt
familiar with them already from other text programs.

The “Alignment”, however, has a minor peculiarity.

Positions the text at the lower edge of the screen.

The text is shown in the center of the screen.

Positions the text at the upper edge of the screen.

Places the text freely in order to determine the position in the image individually.

The text is shown underneath the image. That also applies if the image is shown reduced
in size.

Should you not wish to have separate text animation, activate the option “Fade in text with
image”. 

Should the text be shown animated, you can select various ready-made animations from the list.
You can still adjust the animation using the “Edit” button. You can also see a preview of the
animations there.
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“Rotation around the center of the text” refers to animations in which the text is rotated. Under
“Edit” you can also determine a different rotation center.

Sound

Folder icon Using the yellow folder you can assign
commentaries or pieces of music already
included to an image. 

Play icon Plays back the music file assigned to. 

Record Opens the “Sound Wizard” and you can
then record a commentary to go with the
image.

Volume Determines the volume of the sound when
played back.

Fade background music You can determine whether the volume of
the background music should be
faded/decreased when playing back the
sound. 

Play back the full length of the sound Plays back the sound in its entirety and
thereby adapts the exposure time of the
image to the length of the sound.

Continue to play the sound after the duration
set

With this option the image can have a
shorter duration than the sound. The sound
then simply continues to be played on into
the next images until it has come to an end.

Fade out the sound after the duration set Should the exposure time of the image have
come to an end, but the sound be longer,
with this option the sound is faded out at the



97Properties of slide show objects

Copyright © AquaSoft GmbH 1999-2010

end of the image. Under “Duration” you can
set the fading out time.

Transparency

“Animated transparency” is described in the design options under Animated transparency.

4.2 Text

In the “Object settings” of a “Text” object you can configure the following settings:

The “Text Object settings” do not differ from the “Text Object settings” in the case of the
images. In this case there is only not the “Fade in text with image” option. The “Text” object is
an independent “SlideShow objects”, can, however, nonetheless, be faded into images and
videos.

Transparency

“Animated transparency” is described in the design options under Animated transparency.
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4.3 Video

With the"Video" object you can configure the following settings in the “Object settings”:

Video

File name Shows you the path and file name of your video. Using
the yellow folder you can also exchange the video for
another video file.

Duration If you have once changed the playback time of the video,
you can set the correct video length again with a click on
the time.

Play back video entirely If the option is selected, the full length of the video is
played back. If you deselect the option, you can set the
playback duration individually.

Aspect ratio Retain: The video retains outlines when being played
back.

Crop: Parts are “cropped” from the edge of the video
until the video fits into the correct aspect ratio without
edges emerging.
Distort: The video is inserted into the aspect ratio of the
slide show, whereby a distortion of the image takes place.

Alignment Determines where the video is supposed to be positioned
on the screen.
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Transition A cross fading effect can also be assigned to the video
here. Using “Adjust” the transition can be individually
configured.

Sound

Here you can determine if the background music should be faded out when the video is played
back. If the video does not have its own sound, but perhaps a noise has been recorded, set the
volume of the video to 0% and remove the check mark beside “Fade background music”.

Transparency

“Animated transparency” is described in the design options under Animated transparency.

4.4 Sound

With a “Sound” object the following settings are possible:
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With the folder icon you can insert or remove a music file.
The track selected is shown on the left next to the icon.

Plays back the music file

Opens the “Sound Wizard”. With this you can record a
commentary for the image via a microphone connected to
the PC. You can find more on the “Sound Wizard” here.

Volume 
Displays the volume at which the sound is supposed to be
played back.

Fade out background music
If this option is enabled, the background music is faded
(volume decreased) when the music file is played back. 

Play back the full length of the
sound

Should this check mark be selected, it means that it plays
back the full length of the “Sound” object.

Continue to play the sound after
the duration set

With this option the sound can receive a shorter exposure
time. The sound is then simply played on into the next
images until it has come to an end.

Fade out the sound after the
duration set

Should you wish to only play back the sound for a certain
period of time and then end it, you have to select this
option. Under “duration” you can set the fading out time.

The volume of a sound object can be controlled individually.

Only use unencrypted music tracks for your slide shows. For legal reasons, AquaSoft ®
SlideShow does not support the use of encrypted music tracks.
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4.5 Collage

With “Collage” objects you have the following possibilities for settings:

Image

Aspect ratio Images have an aspect ratio which is comprised of the
height and width of the image. 

Retain: The collage retains outlines when being played
back.

Crop: Parts are “cropped” from the edge of the collage
until the collage fits into the correct aspect ratio without
edges emerging.
Distort: The collage is inserted into the aspect ratio of
the slide show, whereby a distortion of the image takes
place.

Alignment Determines the position of the collage on the screen.

Fill background The background is always filled if the image or the
collage is reduced in size or the collage differs from the
slide show aspect ratio set. It can then occur that the
previous image “shines through”. This can be prevented
by means of this function. The color used for filling the
background can be changed at your option. In the case
of “image within image” effects, the function must be
deselected.
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Transition Here the “Transition” can be set or also deselected. 

Transparency

“Animated transparency” is described in the design options under Animated transparency.

4.6 Chapter

In the “Object settings” of the “Chapter” only a section name can be specified. This serves to
provide a better subdivision of your show. This chapter name will be loaded into SlideShow-
Manager later,provided it is installed. The chapters can thus later be selected individually in a
CD/DVD menu and played back.

4.7 Particles

The “Particle” object shows your images in a minimized form and moves them on the screen.

This feature is only available from <%PRODUCERPROGRAMNAME_R_ORIG%>
Deluxe.

In the “Object settings” of the “Particle” object you can adapt the representation to your wishes.

Inserts additional images into the “Particle” object.

Removes selected images from the “Particle” object.
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Under Direction you can set in which direction
the particles disappear.

Directions:

0 degrees = the particles move out of
the image towards the right
90 degrees = the particles move out of
the image towards the bottom
180 degrees = the particles move out of
the image towards the left
270 degrees = the particles move out of
the image towards the top

You set the pace of the movement under
“speed”. The higher the value is, the faster
the particles fly over the screen.

Here you determine the size of the particles.

With the number of particles, you set the
quantity of particles shown.

Here you can select an animation for the
particles.

Here you set how strongly the movement
should be carried out. The higher the
number, the stronger.

The frequency specifies how often the
movement is carried out. The smaller the
number, the lower the number of movements.

The “Particle” object can in addition also be provided with movement paths. In AquaSoft ®
SlideShow Studio you can even rotate the “Particle” object. 

5 Controlling the slide show

5.1 Automatic course

It is standard for the images in a slide show to be automatically played back in sequence. In that
respect, you determine in the “Object settings” of the “SlideShow objects” how long an
“image”, “text” or “collage” is shown.

5.2 Manual control

Should you wish to move on manually during the show, you can configure the “SideShow Player”
accordingly in the “SlideShow settings”.

The “SlideShow settings” always refer to the current show open. 
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From the menu bar you can open the “SlideShow settings” using the  icon. Alternatively
you can also open the dialog using “Slide Show” -> “SlideShow settings”.

Via the “Basic settings” you can access the “Player configuration” directly.

The “Start after a pause” option switches the show over to being continued manually. You can
then continue the show using the cursor and scrolling keys.

If you activate “By mouse click” in the dialog, you can continue your show by clicking the mouse.

5.3 Automatic and manual course mixed

With AquaSoft ® SlideShow it is likewise possible to continue parts of the slide show manually
and let other parts play back automatically. You can alter this as you please.

In the “Toolbox” you will find two “SlideShow objects” for this purpose:
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These two objects make it possible to switch between continuing the show manually and letting it
run automatically. By double-clicking or by drag-and-drop you can insert the objects into your
show. 

If you, for example, insert the “Pause” object behind the 3rd image, the show will stop before the
4th image and wait for you to continue using the keyboard or mouse.

The manual replay can be interrupted again with a “Play” object. For that purpose, insert the
“Play” object at the point where the automatic course is desired.

Artificial pause:

You can also insert a “Play” object directly behind a “Pause” object. Thus, the show will be
stopped at the image before the “Pause” object and, as soon as you continue, the show continues
to run automatically.

If you convert your show into a video DVD, this function of the two objects is lost. To
pause a video DVD, you have to use the pause key on the remote control.

5.4 Repeating the slide show infinitely

From the menu bar you can open the “SlideShow settings” using the  icon. Alternatively
you can also open the dialog via “Slide show” -> “SlideShow settings”. Under “SlideShow
end” you can enable the repeat function.
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If you convert your show into a Video-DVD this functionality will be lost. If you create
your Video-DVD with SlideShow-Manager you can there activate the repetition of the
of replay.

6 Export options

6.1 DVD-Player

For the DVD player your show must be converted into a video and then burned as a video DVD.
This function is provided by the “Video Wizard”.

Video Wizard

With the “Video Wizard” you can quite easily burn your show onto a DVD and thus play it back on
the DVD player. Under “Wizards” you can open the “Video Wizard”.

DVD
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Creates an MPEG 2 video and burns it onto a DVD as a video DVD.
Resolution: 720x576 

SVCD

Creates an MPEG 2 video and burns it onto a CD as an SVCD.
Resolution: 480x576

VCD

Creates an MPEG 1 video and burns it onto a CD as a VCD.
Resolution: 352x288

Select the “DVD” option. “VCD” or “SVCD”. Then click “Continue”.

In the settings dialog you can still set various options. The “TV border correction” is required if
the television frame covers up the visible area at the edge. 

The “Filming standard” is automatically set to PAL, the European filming standard. NTSC can
also be set. The aspect ratio is automatically adjusted to the aspect ratio of your slide show. If you
have created a 16:9 show, “PAL (16:9)” is automatically set. With a 4:3 slide show “PAL (4:3)” is
selected. 

Before the DVD can be burned, it must first be converted into a video. It must be saved to the hard
disk prior to the burn process. You can decide the storage location and the name under “Video
file”. 

Then click “Continue” and “Create video”. You can access the “Burn video on CD/DVD”
option in the “Video Wizard”.



108 AquaSoft SlideShow - Help

Copyright © AquaSoft GmbH 1999-2010

Here you can burn a video file already created (mpg video), which you have saved on your hard
disk, onto a CD/DVD.

Specify the relevant mpg file and what type of video is concerned.

SlideShow-Manager

In  AquaSoft ® SlideShow Studio you can also use „SlideShow-Manager“ to burn your CDs/
DVDs. It allows to burn multiple shows on one DVD and to create a DVD menu. If you're using 
SlideShow Deluxe and want to use „SlideShow-Manager“ you can purchase it as a separate
product.

You can open „SlideShow-Manager“ from the "Wizards" menu. 
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Select a template for your DVD menu and adjust the individual settings for the menu.

Under „DVD-Menu“ specify aspect ration and video format.

By clicking the button a dialog for burning the shows opens. Select „Video DVD“.
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With „Burn project“ you create a video DVD. Click "Next" and "Export project".

You can find an extensive description of „SlideShow-Manager“ in the help files of „SlideShow-
Manager“. You can find it under "Help" in „SlideShow-Manager“ .

6.2 PC-Show

Your slide show can also be played back on a different PC, on which AquaSoft ® SlideShow is
not installed. 

The CD/Archiving Assistant will assist you in burning your slide shows with all the data to a
CD/DVD or archiving them on the hard disk.

Under “Wizards” you can open the “CD/DVD and Archive Wizard”.

After selecting the task, click “Next”.

Creating and burning a slide show CD:
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Specify a “title” for the CD/DVD. This title is used as the name of the CD/DVD.

Should you use fonts in the case of which you are not sure that they are installed on other PCs,
you can also burn them onto the CD/DVD.

Archiving the slide show, preparing the CD or passing on the slide show

This option enables you to save all data (ads file, images, music) in a common directory. This
option is also very well suited to archival storage. In this way the slide show can also be saved on
external data carriers (hard disks, USB sticks …).

In order to save disk space, you can pack all the data into a ZIP archive. 

Should you use fonts in the case of which you are not sure that they are installed on other PCs,
you can copy these as well.

"Protect images from being accessed":

Should you wish to pass on the slide show, however not permit access to your images, you can
have your images protected. This function is not suitable for archiving, since this show can no
longer be edited. It can only be played back. It is no longer possible to restore the images. You
should not delete your original images from the hard disk.

You should copy the “Slide show player” in order to be able to play back the show on computers
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on which AquaSoft ® SlideShow is not installed. Without this player you cannot otherwise play
back the show.

Click “Next” and then click “Start”. Now all necessary data for the show will be copied into the
folder specified or combined into a ZIP archive.

6.3 Additional video formats

For that purpose, select the “User-defined video” option in the “Video Wizard”. In the dialog you
can now select additional formats under “Video format”.

Check in advance with which codec videos have to be created, so that your DVD player plays them
back (Operating Instructions). Then check whether this codec is installed on your PC. If not, you
have to install the codec.

AVI-Video

AVI ist ein weit verbreitetes Videoformat und wird auch von neueren DVD-Playern abgespielt. 

Stellen Sie die gewünschte Auflösung ein und unter „Komprimierung“ wählen Sie den
entsprechenden Codec aus.

Prüfen Sie vorher, mit welchem Codec diese AVI-Videos erstellt sein müssen, damit Ihr DVD-
Player diese abspielt (Betriebsanleitung). Prüfen Sie anschließend, ob dieser Codec bei Ihnen auf
dem PC installiert ist. Falls nicht, müssen Sie den Codec installieren. Die AquaSoft ® SlideShow
liefert keine Codec mit.

In unserer FAQ finden Sie weitere Informationen dazu.

Bitte beachten Sie, dass ein AVI-Video nicht größer als 2 GB sein sollte. Die meisten
Player spielen ein größeres AVI-Video nicht ab. 

Nicht jeder Codec unterstützt alle Auflösungen.

WMV-Video

Dieses Format steht nur in der AquaSoft ® SlideShow Studio zur Verfügung.

Für die Erstellung eines Videos im WMV-Format sollten Sie eine aktuelle Version des Windows
Media Players installiert haben. 

http://forum.aquasoft.de/viewtopic.php?t=6109
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Beim WMV-Format können Sie eine sehr hohe Auflösung für das Video verwenden. Die fertigen
Video können mit dem Windows Media Player abgespielt werden. Derzeit unterstützen nur wenige
DVD-Player dieses Format.

6.4 Archiving a slide show

The “CD/DVD and Archive Wizard” offers you the opportunity to burn the complete show with all
the data onto a CD/DVD or export it to an external drive.

This procedure is explained in the PC Show section.

7 Image editing

7.1 Integrated image editing

It is our goal to provide you with all necessary tools in one single program, the AquaSoft ®
SlideShow. Therefore we integrated image editing functionality that allows you to enhance your
photos for the slide show. Of course there are specialized image editing applications that go far
beyond the capabilities of the image editing module in AquaSoft ® SlideShow but it should be
possible to solve the most important tasks inside the program.

Use the right mouse button to click on the image and select the option "Optimize image". There
are functions to crop and rotate images, for color correction, adjustment of brightness and contrast
and some filters like blurring. By using the magnifying buttons (just like in "Layout designer") you
can adjust the size of the display of the image or image segment. 
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None of the provided image editing functions modifies your original image.

The modification only affect the display of the images inside the slide show.

7.2 AquaSoft ® Image effects

The "Image effect editor" is only available in AquaSoft ® SlideShow Studio.

With "Image effects" graphics can be optimized or spiced up. From a simple shadow over
pleasing frames and collages to branched effect chains (Multiplicating) many things are possible.
Complex effects are combined from different basic modules and allow non-destructive image
editing (the original image always stays untouched).

When you click on an image in the "Image list" or "Timeline" you can select the menu item
"Optimize image".

Under „Effects“ the "Image effect editor" opens.
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With the help of the "Image effect editor" those effects can be assembled and saved to be
reused later. Let's just start with a shadow effect and improve our skills to create a "self-border"
afterwards.
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7.2.1 A simple shadow

You need only a few clicks to assign an unobtrusive drop shadow to an image.

Sub-effects are simply added via the menu. Thus add the sub-effect "Shadow". 

Note: The number of available sub-effects in your version of the application can differ from that in
the image above.

Now you can see that the shadow has been added to the previously empty "effect list". On the
right side of the dialog appear controls that let you adjust the settings of the shadow to your liking.
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At the bottom-left the shadow effect is showcased on the butterfly graphic. 

Each sub-effect can have very different settings. How each of them affects the result you can find
out best by trial and error. In our specific example the offset  of the shadow from the original
image, the angle of the incidence of light, the strength of the blur and the transparence of the
shadow can be specified.

That's all there is to it. Clicking „OK“ applies the shadow to your image. Of course, all the settings
can still be edited later. The original graphic is never changed.
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7.2.2 A "self-border" using multiplication and transformation

We want to achieve an effect that used the image itself to create a semi-transparent border. The
result will look similar to the picture below:

The basic idea of the solution looks like the following:

1. Enlarge the image and assign semi-transparency to it

2. Overlay the semi-transparent image with the original image

Here an important functionality is utilized that is also crucial for the creation of many other complex
effects: Multiplication.

To achieve 2. at all a copy of the original image needs to be stored to be able to overlay the image
that might already be changed by previously assigned sub-effects. The multiplication effect allows
exactly this. By using it the normally flat list of effects will become a tree, because the multiplication
effect can have child elements. The sub-effects can be moved around via drag&drop.

All effects that are children of the multiplication effect are "served" with that state of the image data
source that has been current at the branching point, no matter in which way and how much a
different child element has changed the image.
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Here you see the completed effect: The multiplication effect got a transformation assigned as sub-
effect that enlarges the image by a few millimeters. To that the transparency effect is assigned to
make the image semi-transparent. 

Now we need to use a little trick: To display the original image again we simply add a second
transformation to the multiplication. Only this time no offset, rotation, etc. is set. So the image stays
the same.

Note: Child elements of multiplication effects can have child elements themselves.
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8 Wizards

8.1 CD/DVD- and Archiving Wizard

The “CD/DVD and Archiving Wizard” will be explained extensively in chapter PC-Show.

8.2 Video Wizard

In order to show your show on the television, you can create a CD/DVD for the DVD player with the
Video Wizard. You can access this under “Wizards” -> “Video Wizard”.

An exact description of the wizard can be found in the DVD Player section.

8.3 SlideShow-Manager

The „SlideShow-Manager“ allows to burn multiple shows to a CD/DVD. It creates a CD/DVD
menu that allows to navigate to a certain show.

AquaSoft ® SlideShow Studio already contains „SlideShow-Manager“. If you're using
SlideShow Deluxe and want to use „SlideShow-Manager“ you can purchase it as a separate
product.

You can find an extensive description of „SlideShow-Manager“ in the help files of „SlideShow-
Manager“. A short description is included into this manual in chapter DVD-Player.

8.4 Earth Pilot

With Earth Pilot you can spice up your slide shows with maps, flights in motion or the globe and
with photos of the whole world. The Earth Pilot is a separate product and is available for purchase
in our online shop.

Please note that Google Earth™ is a trademark of Google Inc. You use the interfaces and data
supplied by Google Earth™ on your own initiative and at your own risk. By using an AquaSoft
product you also do not acquire any rights in a Google product. If you would like to use maps and
image material in your presentations, please obtain the consent of the respective proprietor of the
right. AquaSoft cannot impart this right to you.

http://shop.dvd-photoshow.com
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8.4.1 Installation

In order to be able to use Earth Pilot, the Google
Earth™ browser plug-in must be installed. If the
plug-in is not yet installed, you will requested to
install it when Earth Pilot is started. To do so,
simply click this download link. 

The Google web page should look approximately
as shown on the left. Click “Download Google
Earth plug-in now” and install the plug-in.

Before you can begin, you have to specify a target directory in which Earth Pilot is supposed to file
all images and videos created, by clicking “Settings”.

8.4.2 Navigation in Google Earth

You can navigate within the globe, as is usual with Google Earth™. You can move the globe with
the mouse or move the navigation elements in the upper right-hand area.

8.4.3 Creating camera pans

A tracking shot always has a starting position and a final position. Navigate to a desired section of
the map and click “Set start position”. Then move the map to the target and click “Set end
position”. You can do that as often as you wish and in any desired sequence. In so doing, you
have specified a camera pan, the trajectory of which you can see by clicking “Preview”. You can
determine how long the flight should last by changing the details in the field “Flight duration”. The
height of the flight is, on the one hand, apparent from the flight speed, however can be adjusted
using the “Flight altitude” control. 

Should you be satisfied with the flight, click “Create and insert video”. Then Earth Pilot begins to
compute a video of the camera pan. This can last several minutes or even a few hours, depending
upon the speed of your Internet connection, as well as your PC. Once the video is finished it is
automatically inserted into your slide show. You can now exit Earth Pilot or compute further videos.

http://code.google.com/apis/earth/
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8.4.4 Inserting maps as images

Navigate to the desired section of the map and click “Insert map section”. Earth Pilot now
generates an image of the map, saves it and inserts it into the slide show. You can then exit Earth
Pilot or insert further map sections.

8.4.5 Downloading images

With their "Panoramio" service Google provides the option to load thousands of images from
many places of the world. You visited Paris but didn't take a cool picture of the Eiffel tower? No
problem, there are hundreds of photos taken by other people available. Simply navigate to the
location of your choice and click "Load images". Earth Pilot will now calculate the coordinates and
show all suiting images in the list on the right side. Select one or more images and click "Insert
selected images". Now Earth Pilot will download the images and insert them into your slide show.

8.5 Sound Wizard

Using the “Sound Wizard” you can record spoken commentaries and noises with your images
using a microphone connected to the PC.

You will find the “Sound Wizard” in the menu under “Wizards”.



123Wizards

Copyright © AquaSoft GmbH 1999-2010

You can save the resulting files in the slide show directory or in a separate directory.

Under “Record-Settings” you can decide the settings with which the commentaries should be
recorded.

Then click “Next”.

Now all the images in the show with which you can include a commentary will be shown to you in
sequence. To do so, simply click “Record” and then speak your commentary on the relevant
image. Should you make a mistake while recording, you only need to re-record the commentary for
the selected image.
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With “Play back” you can hear your recording. In order to get to the next image, click “Next”.
Once you have finished recording, close the “Sound Wizard”.

The “Sound Wizard” automatically matches up your images with the commentaries recorded.
You can find the recorded file in the “Object settings” of the relevant image. The recording can

also be played back here, using the  button.

The “Sound Wizard” can also be started directly from the “Object settings” of an image. For
that there is the “Record” button.

The length of the image is automatically adapted to the length of the commentary.
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8.6 Import Wizard

With this wizard you can import your images from a scanner or from your digital camera, as long
as these devices respond to the “TWAIN32 interface”. The images are saved and included in the
“Image List”. They can either be improved with the editing function immediately or later.

You can access these under “Wizards” ->“Import Wizard”.

Specify a “Target directory” in which the images should be saved. Selected the desired file
format and, if necessary, adjust the formatting options.

If the images are supposed to be directly included in the “Image List” of the slide show, enable
this function.

Then select the scanner or camera.

Next click “Next” and then click “Start”. Your images are now imported.

8.7 PowerPoint Wizard

With the “PowerPoint Wizard” you can import your PowerPoint presentations into the slide show.
A prerequisite is that MS PowerPoint (Version 8 or later) is installed on your PC.

During import the individual slides are saved as images. All animations and effects will be lost in
the process, however. 

You can start these under “Wizards” ->“PowerPoint Wizard”.

Specify the “File name” of the PowerPoint file to be imported.
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Then click “Next”.

Specify a “Directory” in which the images should be saved. You can use the slide name as the
file name or use the form “Imagexxx”.

Click “Next”.

Now you can set the image options. Select the desired resolution and the image format. Under
“Formatting options” you can configure additional settings relating to the image format.
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Click “Next” and then click “Import”. The slides are now converted into image files and inserted
into your slide show.

8.8 Searching for missing files

AquaSoft ® SlideShow only saves links to your images and music which you use in the slide
show. Should you move, delete or rename your images. AquaSoft ® SlideShow can no longer
access them. You will then see the following notice in the “Layout Designer”.

AquaSoft ® SlideShow cannot retrieve/recover deleted images. 

Under “Wizards”/“Search for missing files” you can call the Search Path Wizard.
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Here you have several search possibilities.

If you are not sure where the files sought are located now, activate the automatic search.

If you know exactly in which directory your images are located, you can also directly specify the
path.

If you want to convert the path from absolute (details of paths are saved in their entirety) to relative
(details of paths are saved in relation to the location of the ADS file) or vice versa, select the
relevant option. 

Then specify the entries that should be adapted.

Click “Next”.

Now select where your images should be sought.

Click “Next” and the search starts. Afterwards the results of the search are shown to you.
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Click “Finish” and your slide show is updated.

9 Variables

In AquaSoft ® SlideShow there is the possibility of having certain image information displayed as
a text in the image, e.g. the date taken, the file name or the path to the image. This occurs by
means of “Variables”.

These have to be specified in the format below in the “Text“ field in the “Object settings” of an
image:

In principle, “variables” have to be enclosed between two “%” signs.

In the “Layout Designer” you will then see the implementation of the “Variables”.
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“EXIF information” on your images can also be included using “Variables”. In that respect, your
image must contain “EXIF data”.

You can check this by clicking on an image and then having the “meta-data” displayed under
“View” -> “Controls”. Should these be empty, your image does not contain this data.

You will find a “list” of all possible “variables” in the program under “Tools” -> “Program
settings” -> “Plug-ins”.

Via the “Info about plug-ins” button a window is opened, in which the “variables” are listed.
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You have to scroll down a bit in order to get to the “list” with the “variables”.

10 Settings

10.1 Slide show settings

The slide show settings can be individually decided for each slide show.

Under “Slide show” -> “Settings” you can access the window for the “Slide show settings”.

You can also access the settings directly via the  button in the menu bar.

Basic settings:

Here you can change the “Standard exposure time" of your images, as well as select a
“Random playback sequence” for your images.

You can adjust the "display quality" according to the performance of your computer here. The
higher the quality the higher is the required performance. This setting is of no importance during
the creation of the video. It concerns the quality when replaying the show using the AquaSoft ®
SlideShow Player. If the "display quality" is too high for your PC this can lead to a jerky replay
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experience of your show.

You can likewise set the “Aspect ratio” of your show here. Should this not correspond to the
aspect ratio of your images, you will get edges or you fit your images into the desired aspect ratio.

Under “SlideShow Player” you can choose between the “Software Player” and the “Standard
Player (DirectX)”. For the “Standard Player (DirectX)” a DirectX 9c-compatible graphics card
with at least 64 MB memory is required. It is also mandatory that you use the manufacturer’s
current graphics card driver!

If you still have an older graphics card or one with little memory please use the “Software Player”.
If your show is set to use the “Standard Player (DirectX)” it will be checked if it is possible to use
it with your graphics card before playing the show. If this isn't the case the “Software Player” is
used automatically.

The “Standard Player (DirectX)” is considerably more powerful than the “Software Player”,
however a corresponding graphics card is required.

You will find settings for the corresponding “SlideShow Player” further on in this section.

Slide show end:

Here you can decide what is supposed to happen at the end of the slide show played back.

Transitions:
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Here you can select which transitions are supposed to be included in the “Random transition”.
All those with green check marks are included, all those with a red cross are not included.

Music settings:

The music settings are explained in further detail here.

Background music:

The topic of background music is dealt with in detail here.

Description:

You can individually personalize your show. Here you can specify a title, author and a description
of your show.

Logo:
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If you want to start your show with a „Logo“ you can select and image here. You can also simply
omit a logo.

Standard player:

The AquaSoft SlideShow Player takes on the task of playing back a slide show. Here you can
decide the settings for it. First check which “SlideShow Player” you are using. You will see this in
the “Basic settings”.

The “IntelliLoad” specifies how many seconds of the show should be loaded in advance.

If you want to use the selected settings as default for every new slide show then click „As default“
. These settings will then be automatically assigned to all future shows. By clicking the button 
„Original settings“ you can reset all settings to the factory values.
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10.2 Music settings

You can reach the music settings via “Slide Show” -> “Settings” -> “Music settings”.

The “Music settings” can be set as desired for each show. The standard settings are illustrated.

You decide here whether background music is
supposed to be included in your slide show or
not.

In the “Background music” menu you can
insert several tracks to provide background
music for your show. Here you can decide
whether this list should be repeated if all tracks
have been played and the slide show has not
yet come to an end.

Via this button you can access the 
“Background music” menu and can remove
or insert tracks there.

Here you can set at what volume the tracks
should be played back (100% = full volume).

The background music can be gently faded
out towards the end of the slide show or
simply broken off.

Here you can specify the length of the fading
out.

If you use “Sound” objects or have recorded
commentaries for your images in your show, it
is expedient to fade out the background music
when playing back these objects. Specify here
to what volume the sound should be faded out.

0% = Fade out completely
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100% = Do not fade

Determines over what period of time the music
should be faded.

Here you can specify whether the background
music should also be faded with included 
“Sound” objects.

If you use breaks and continue manually
during the show, you can decide whether the
music should also be interrupted during an
image break, or whether it should continue. If
a check mark is placed, the music stops
during a break.

10.3 Program settings

The “Program settings” refer to the basic settings of the program and not to the individual
settings for your slide show. For the slide show created by you, the slide show settings are
decisive. 

Under “Extras” -> “Program settings” you can access the program settings.

Plugins:

Contains a list of all plug-ins additionally installed which have been installed by additional
AquaSoft applications.

Add files:
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Here you can determine how files are supposed to be inserted into a slide show and how they
should be arranged in this slide show.

User interface:

Here you will find additional setting options for the user interface of  AquaSoft ® SlideShow.

Temporary directory:
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AquaSoft ® SlideShow from time to time requires temporary disk space on the hard disk. Here
you can specify in which directory temporary files may be buffered. 

Language:

AquaSoft ® SlideShow supports several languages, which you can change here.

Automatic update:
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Here you can set the intervals at which AquaSoft ® SlideShow is supposed to check for updates.

Record sound:

Using the “Sound Wizard” you can record spoken commentaries with your images by means of a
microphone connected to your PC. Configure the recording settings here.

Sound system:



140 AquaSoft SlideShow - Help

Copyright © AquaSoft GmbH 1999-2010

The “Sound system” takes on the task of playing back the music included in the slide show.
Should you have irregularities when playing back the music, set the setting to “Windows
Multimedia” here and then restart AquaSoft ® SlideShow.

CD/DVD writer:

Here the recognized CD/DVD writers are shown.

Confirmation:
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Select the dialogs to be shown here.

Automatic saving:

Here you can determine whether backup copies should automatically be generated while you are
working on a slide show. Under “File”/“Open”/“Restore” you can access an earlier status of your
work.

Storyboard:
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Configure your settings for the “Storyboard”.

Layout designer:

You can configure settings for the “Layout designer” here.

Timeline:
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Configure the settings of the “Timeline” here.

Image list:

Here you can select which information should be displayed in the “Image list”.

11 Technical information

11.1 Common preparations

Directories

In order to achieve a good result quickly and effectively, you can make some minor preparations in
advance. AquaSoft ® SlideShow saves an image list and, in that respect, keeps an eye on all
directories specified.
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Image format 

AquaSoft ® SlideShow supports, inter alia, the following image formats.

As background sound the following file formats may be used:

Please note that MID and RMI files cannot be used when creating the video with the Video Wizard.

Only use unencrypted music tracks for your slide shows. For legal reasons, AquaSoft ®
SlideShow does not support the use of music tracks which have been encrypted by
DRM or similar procedures.
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11.2 Installation

To install AquaSoft ® SlideShow we suggest at least the following system setup. More resources
will lead to higher quality playback: 

Hardware

CPU - 1 GHz 
Graphics board - DirectX 9c-compatible graphics board with 64 MB RAM for use of the
DirectX-player. For older graphics boards the Software-Player is available to play slide shows.
RAM - 512 MB 
Harddrive - 150 MB (burning (S)Video-CDs may need space up to 1,2 GB for a short time,
burning Video-DVDs may take up to 10 GB temporarily) 
CD/DVD-burner - (optional) 

Operating system 

Windows 2000, XP Home and Professional, Vista 

not supported are the operating systems: 
DOS, Windows 3.x, Windows 95, 98, ME, Unix, Linux, Apple Macintosh, Novell, etc. 

11.3 Full screen mode with different screen resolution

You can modify the graphic mode for the full screen display in the player settings. When switching
the screen resolution Windows can only assign a fixed or no frame rate at all. Since we can't know
your graphics card/monitor combination we omitted the assignment of a fixed frame rate. This was
done to prevent any danger for your monitor. Windows automatically switches to one of the
possible modes, which you can change yourself. (see Control panel -> Display -> Settings) 

This hint is only of interest if you want to work with a modified full screen mode. The problem does
not exist in window mode.
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12 Order info
The easiest way to order a product by AquaSoft is to visit our website at shop.dvd-photoshow.com.
Here you can always find the newest offers and also bundles (combinations of several products),
which you can save a lot of money with. In addition you'll receive the newest updates.
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13 Other programs by AquaSoft
AquaSoft SlideShow is just one of many useful programs created by AquaSoft. On the following
pages you can find additional programs with interesting features and useful enhancements.

13.1 AquaSoft ® Barbecue

The new image processing software AquaSoft ® Barbecue

 
The new image processing and managing software AquaSoft ® Barbecue is photo studio as well
as image factory. With just a few clicks you design your  images yourself. The new built-in undo
functionality makes mistakes practically impossible. Macros are being created using the mouse -
as easy as never before. All steps in the process can be saved and are reusable for an unlimited
amount of images. AquaSoft ® Barbecue takes into consideration the development of digital
photography. Therefore we integrated JPEG-2000 and the reading and writing of EXIF data. Thus 
AquaSoft ® Barbecue becomes a must for all owners of digital cameras. An extensive manual in
PDF format is waiting for you, as well.

Some features:

· changing resolution and formats
· evaluating EXIF data and their use as renaming information
· static integration of water marks, stamps, logos, texts and own drawings into the image
· zoom functionality
· extensive image editing program

For instance you can convert hundreds of blue-cast, to dark 640x480 BMP images into colour
corrected 320x200 JPEG images, for which you can set the compression rate, that are fit for the
Internet. Especially the integration of image editing, file conversion, the writing of JPEG2000 and
Lurawave into an automated batch conversion makes it a program that the community has been
waiting for for a long time.
In short, AquaSoft ® Barbecue is a batch-image-converter with image editing functionality.

More information on the Internet: www.barbecue.aquasoft.de

http://www.barbecue.aquasoft.de
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13.2 AquaSoft ® DiscMenu

AquaSoft ® DiscMenu - Your professional CD-ROM-Publishing-System

You have the best contents but nobody looks at them? Endless amounts of data can be stored on
CDs or DVDs. But it needs a lot of care to make these data accessible to the user. What if you
could organize the contents of your CD through easily to create HTML-pages? Great idea! What's
missing now is a suitable environment because a normal web browser for displaying the page
neither looks professional nor does it provide the opportunities to customize its look. On top of that
there are quite a few obstacles to overcome. Good that there is AquaSoft ® DiscMenu.

The start menu for your CD or DVD:
· the auto-start menu for your installation file and other applications
· the business card of your company with navigation
· your product presentation on CD or DVD as advertisement
· the information system for your documentation
· a new way for your multi-media application

You want to distribute eLearning-products or start eBooks, audio books, movie or sound files from
CD?

AquaSoft ® DiscMenu provides the features of a multi-media authoring system!

More information on the Internet: www.discmenu.aquasoft.de

http://www.discmenu.aquasoft.de
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13.3 AquaSoft ® Multimediawerkstatt

Multimediawerkstatt - digital learning - a child's play

AquaSoft ® Multimediawerkstatt is a software for playfully learning the use of computers and
media. Designed for children in grade school Multimediawerkstatt is an open creativity platform
that combines painting, writing, voice recording and presenting in one program. 

Intuition and esprit - childlike fantasy burnt on CD
Due to its intuitive comprehensibility Multimediawerkstatt is particularly suited for young students
and users without any computer experience. Almost  in no time adventures are cast in digital
format, and different sources are connected to self-running presentations. Just like a slide show
are the stories of our children replayed on computer or burnt on an auto-starting CD. A multimedia
software with esprit for school and leisure time.

More information on the Internet: www.multimediawerkstatt.aquasoft.de

http://www.multimediawerkstatt.aquasoft.de
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13.4 AquaSoft ® PhotoAlbum

AquaSoft ® PhotoAlbum - Get more out of your photographs

Digital photos are great but they aren't everything. You will come to a point where you wish you
could look at them in print. That's way you can say, paper photographs are alive and well.

With AquaSoft ® PhotoAlbum you can offer more than just lose photos to the admirers of your
artwork. No boring albums but exciting effects give your pictures center stage. Whether you want
to spice up your desktop, produce creative photo books or wake up your printer from its
hibernation is up to you. In AquaSoft ® PhotoAlbum everyone finds what is needed. 

And these are the three easy steps:
· adding images
· selecting a template
· creating the photo album

AquaSoft ® PhotoAlbum already comes with many prepared templates. But with the integrated
template editor you can design your album to the smallest details yourself, as well. There are no
limits. Title pages, chapters, thumbnail view (contact print) and much more can be designed and
positioned. Create professional photo books just as easy as funny ones, e.g. with pictures that
seem like pasted in.

Enough of always the same desktop wallpaper? With the integrated Desktop-Album you can revive
the memories of your last holidays. It's not just a simple one-after-the-other of your photos but they
are professionally embedded in an interesting environment.

More information on the Internet: www.photoalbum.aquasoft.de

http://www.photoalbum.aquasoft.de
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13.5 AquaSoft ® PhotoKalender

AquaSoft ® PhotoKalender - Your photos, around the year.

There's always a time to give gifts. So, what's more suitable than to give a calendar, then?

AquaSoft ® PhotoKalender is a universal program for the creation of customized calendars.
Ready-made templates  ensure the desired result with just a few clicks.

And these are the three easy steps:
· adding images
· selecting a template
· creating the photo calendar

AquaSoft ® PhotoKalender already comes with many prepared templates. Calendars for printing
or your desktop,  for giving away or keeping. Cover pages, any number of pictures per page,
appointment books, weekly, monthly, yearly calendars, etc. - leave room for your creativity. Create
new calendar layouts to the smallest detail with the help of the integrated template editor. Whether
simple, advanced, funny or formal - everything can be achieved in a professional manner.

Specify birthdays and appointments. Every event will be displayed with photos on the correct day.
PhotoKalender also imports your appointments and birthday list from MS Outlook.

The Desktop-Kalender brings your photos as a photo calendar to your desktop, including your
specified events. This too includes your MS Outlook events.

More information on the Internet: www.photokalender.aquasoft.de

http://www.photokalender.aquasoft.de
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13.6 AquaSoft ® ScreenShow

AquaSoft ® ScreenShow - Take a break and enjoy your pictures.

People always have been charmed by moving pictures. Put the magic of your photos on your
screen. With AquaSoft ® ScreenShow you can create your own photo screen savers with
impressing transitions and background music. And it can be done  with just a few mouse-clicks.
You can use these screen savers on your own PC or you can distribute them, e.g. per eMail.

And these are the three easy steps:
· adding images
· entering a title
· creating the screen saver

More information on the Internet: www.screenshow.aquasoft.de

http://www.screenshow.aquasoft.de
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13.7 AquaSoft ® WebShow

AquaSoft ® WebShow - Waltzing from a photo to a website

While the Vienna Waltz uses three steps converts the program AquaSoft ® WebShow your
photos into a ready-to-go website. That's right! In just  three steps a complete website is created
including picture frames, background, thumbnail navigation and, if you wish, transition effects.

And these are the three easy steps:
: 
· adding images
· selecting a template
· launch the website

Whether for family or for presentations in the company, for you it is important to embed your
photos and pictures into a pleasing Internet site with just a few clicks. From the abundance of web
templates you can create a professional web project with overview page (thumbnails), navigation
buttons and comments.

And those who want can dance the foxtrot. Then there is a fourth step available for setting the
page properties where all possible configuration can be made. E.g. you choose a picture frame, a
certain background color, a button style - even whole themes are available. Due to the powerful,
XML-based scripting language of the templates you can create your very own templates, as well.
There are virtually no limits: you can use everything that is supported bei HTML, PHP, ASP,
Javascript etc. Again, you can but you don't have to. Because AquaSoft ® WebShow has almost
everything prepared for you.

More information on the Internet: www.webshow.aquasoft.de

http://www.webshow.aquasoft.de
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14 AquaSoft ®

14.1 If you have problems

The AquaSoft-homepage offers software on the topics of education, image editing and image
management as well as further shareware and freeware for download. 

Visit our homepage at www.dvd-photoshow.com. You will find downloads, FAQ, forums and
information on our products. 

If you have trouble with an AquaSoft product or questions, criticism, praise, please proceed as
follows: 

· Check the manual or the according help file.  

· Try finding an answer in the FAQ (Frequently Asked Questions).

· Visit the according forum. There users can exchange experiences and can ask questions.
Write your own entry. Sometimes it is easier for another user to understand the question
than for a whole team of developers - and the answer might come quicker, too.

· Only after those steps didn't succeed, write or call us. We take your suggestions as
important help, but we also need time to advance the software.

· The contact email address is: info@aquasoft.de  

http://www.dvd-photoshow.com
mailto:info@aquasoft.de
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Visit us on the Internet:
www.dvd-photoshow.com
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